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THIS 1S WHAT LEARNING LOGIC GATES FEELS LIKE

SEE, YOU JUST CONNECT THIS 12 INPUT REVERSE
FLIP-FLOP TO THE CONTROLLED TWO-THIRDS ADDER,
WHICH RESETS THE LATCHES IN THE NOT-NAND RELAY
ARRAY, THEN LOOP BACK TO ODD-NUMBER INPUTS
AND REVERSE ALL YOUR SWITCHES/

AND WHAT'S

-
THAT DO SUBTRACTION.

https://www.smbc-comics.com/comic/logic-gates
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Limitations of State Machines Discussed So Far

* The State machines that we have discussed so far have been designed
for a specific application (e.g. controlling traffic lights)

* Changing the application requires building a new state machine, new
hardware, ...

. This reasoning
* We want to have a general-purpose machine that i< the birth of

e Can be used for all kinds of different applications software!
e Can be reconfigured quickly

—->We want general purpose hardware that is “configured in memory” for a particular
application
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Von Neumann Model

 Components of a computer built based on Von Neumann

Processing Unit
Control Unit
Memory

Input

Output

Buses

John Von Neumann
(born 1945 in Budapest)
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Von Neumann Model

Processing Unit

Input

(Keyboard, Disc,
Network, ...)

Control Control Unit

Output
(Monitor, Printer,
Network, Disc, ...)

Central Processing Unit (CPU)

The Von Neumann Model is the classical computer model — it is the basis of most CPUs



Von Neumann Model

Processing Unit

Register
File

Control Unit

Instruction Program
Register Counter

Note for Task 1 of the practical:
|/O Peripherals can be “memory
mapped”

(their registers are addressable
just like memory locations)
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Input
(Keyboard, Disc,
Network, ...)

Output
(Monitor, Printer,
Network, Disc, ...)



Harvard Architecture

CPU
Processing Unit

Register
File

Control Unit

Instruction Program
Register Counter

e Harvard Architecture is similar to a the
Von Neumann Architecture

» Difference: data and instruction memory
are separated

e We use a Harvard Architecture in the
first lectues
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Data Memory

Instruction Memory

Input
(Keyboard, Disc,
Network, ...)

Output
(Monitor, Printer,
Network, Disc, ...)



Arithmetic Logic Unit (ALU)

 The ALU is a combinational circuit performing
calculation operations

* Basic Properties

. Eakes two n-bit inputs (A, B); today typically 32 bit or 64
it

* Performs an operation based on one or both inputs; the
plerforrlned operation is selected by the control input
alu_se

e Returns an n-bit output; It typically also provides a status
output with flags to e.g. indicate overflows or relations
of A and B, such as A==B or A<B

input A inputB

!

NV
ALU /> status

ALU output

input A input B

ADD

SUB

: AND

’ XOR

VERVER R,

alu sel

~

alu output



Register File

* The register file contains m n-bit registers

* |[n a given clock cycle one n-bit value can be stored
in the register selected via the signal R,,; In case
RegWrite is low, no register is written

* |n each cycle two registers can be read and are
provided at the outputs A and B. The registers to
be read are selected via R, and R,

* The register file is essentially a memory with one
write port and two read ports

Data input —»

Read Port A

Register File

Data

Read Port B

— output A

— output B
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Data Registers (Register File)

* In case of RISC-V, the register
file consists of 32 registers

* 5 bit are needed for Ry, R,, Rg X
x1

X2

x3

10
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Register File

RA
i— Output A
RB

Data Registers (Register File)

:'; Output B

11
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Data Registers (Register File)

RegWrite

* Basic Properties

* Data registers with two
output MUX

* Input is stored in any
one of the registers
(selection via R, signal)

Output A

* Typical register sizes: 8,
16, 32, 64 bit

Output B

Input

12
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PrOCESS|ng U n|t Processing Unit

Data
ALU Registers

* The processing unit constitutes the data path of the CPU

* Based on control signals that are provided as inputs operations are
performed in the ALU and data registers are updated

13



A First Simple Datapath for Our CPU

Data

Read Port A

Register File

Read Port B

>ALU

* How do we get data from “outside” into the register file?

* Where do we get the control signals from?

www.iaik.tugraz.at

14



Processing Unit

Data
Registers

Control Unit

Instruction Program
Register Counter

CPU

Input

(Keyboard, Disc,
Network, ...)

Output
(Monitor, Printer,
Network, Disc, ...)
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Control Unit

Instruction Register

Instruction Program
Register Counter

* The instruction register stores the
instruction that shall be executed by the
data path

* The instruction decoder maps the Control
instruction register to control signals Instruction TSTAEer Signals

Register decoding

16



A First Simple Datapath with Control for Our
CPU

Read Port A
Register File
Data >ALU
Read Port B

What is an instruction?

How do we encode an instruction?



Instruction Set Architectures



Instruction Set Architecture (ISA)

An instruction is the basic unit of processing on a computer

The instruction set is the set of all instructions on a given computer
architecture

The ISA is the interface between hardware and software

Options to represent instructions

* Machine language:

* Asequence of zeros and ones, e.g. 0x83200002 -> this is the sequence of zeros and ones
the processor takes into its instruction register for decoding and execution

* Length varies can be many bytes long (up to 15 bytes on x86 CPUs)

* Assembly language:
* Thisis a human readable representation of an instruction, e.g. ADD x3, x1, x2

www.iaik.tugraz.at

Software

ISA

Hardware

19



Instruction Set Architectures

* There are many instruction set architectures from different vendors
* Examples: Intel x86, AMD64, ARM, MIPS, PowerPC, SPARC, AVR, RISC-V, ...

* Instruction sets vary significantly in terms of number of instructions

* Complex Instruction Set Computer (CISC)
* Not only load and store operations perform memory accesses, but also other instructions
* Design philosophy: many instructions, few instructions also for complex operations
* Hundreds of instructions that include instructions performing complex operations like entire encryptions
* Examples: x86 and x64 families

* Reduced Instruction Set Computer (RISC)
* RISC architectures are load/store architectures: only dedicated load and store instructions read/write from/to memory
* Design philosophy: fewer instructions, lower complexity, high execution speed.
* Instruction set including just basic operations
* Examples: ARM, RISC-V

* One Instruction Set Computer (OISC)

* Computers with a single instruction (academic), e.g. SUBLEQ
see https://en.wikipedia.org/wiki/One_instruction_set_computer



Competition Between Instruction Sets

* Given a fixed program (e.g. written in C), which instruction set leads

to the smallest code size (the smallest number of instructions need to express
the program)?

to best performance on a processor implementing the ISA?

lowest power consumption on a processor implementing the ISA?



Open vs. Closed Instruction Sets

* Most instruction sets are covered by patents

- Building a computer that is compatible with that instruction set requires
patent licensing

e RISC-V (the instruction set of this course)
* isopen : 4 RISC ’
» developed at UC Berkeley
* An instruction family from low-end 32bit devices to large 64bit CPUs
* Significant momentum in industry and academia
* More information and full specs available at https://riscv.org/



Processing Unit

Register
File

Control Unit

Instruction Program
Register Counter

PLRISC-V/"

CPU
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Data Memory

Instruction Memory

Input

(Keyboard, Disc,
Network, ...)

Output
(Monitor, Printer,
Network, Disc, ...)
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First RISC-V Basics



RISC-V Instruction Sets

* Base instruction sets
* RV32l (RV32E is the same as RV32l, except the fact that it only allows 16 registers)
e RV64|
e RV128I

* Extensions
* “M” Standard Extension for Integer Multiplication and Division
“A” Standard Extension for Atomic Instructions
“Zicsr”, Control and Status Register (CSR) Instructions
“F” Standard Extension for Single-Precision Floating-Point



Register File and ALU

 We focus on RV32|

* The ALU and the register file are all
32 bit

* Our register file consists of 32
registers (Note: register x0 always
reads zero; writing to x0 does not
lead to storing a value)

Read Port A

Register File

Data

Read Port B

>ALU
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Basics

The base instruction set has fixed-length 32-bit instructions

* The operation to be

What information to executed
include in the 32 IR | 0x001101B3
i+?
bit: e Parameters (e.g. source

registers, target register,
constants)

0000000 00001 00010 000 00011 0110011

27
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Q funct? rs2 rsl funct3 rd | opcode R-Type

31 e S —— il 7 b 0

‘ imm rsl funct3 rd ‘ opcode I-Type

31 25 24 20 19 15 14 12 11 7 6 0

| Imm rs2 rsl funct3 imm | opcode S-Type

31 12 11 i 6 0

‘ imm rd ‘ opcode U-Type

* Opcode, funct3, funct?:

* Imm:

*rsl, rs2:

° rd:

definition of the functionality

immediate values (constants)

source registers

destination register

28
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R-Type Instructions

* These are instructions that perform arithmetic and logic operations based
on two input registers

31 25 24 20 19 15 14 12 11 I B 0

funct? rs2 rsl funct3 rd opcode R-Type

 rs1 defines source register 1

* rd defines the destination register

29



Example

IR 0000000 00001 00010 000 00011 0110011
31 25 24 20 19 15 14 12 11
0000000 rs2 rsl 000 rl 0110011

5 bit values to do the indexing in

our register file

www.iaik.tugraz.at
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Example

IR , R3, R2,
31 25 24 20 19 15 14 12 11
01 00011
31 25 24 20 19 15 14 12 11

funct?

=

rsl

funct3

rd

opcode
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Machine Language and Assembly

* Every instruction can be represented in human readable form = assembly

* Every instruction can be represented in machine readable form > machine
language

* There is a strict 1:1 mapping

Machine

IR ADD, R3, R2Z, Language

31 25 24 20 19 15 14 12 11 P 0

00010 000 00011

32



RV 321 Base Instruction Set

imm[31:12] rd 0110111 LUI
imm[31:12] rd 0010111 AUIPC
imm[20[10:1]11]19:12] rd 1101111 JAL
imm]|11:0] sl 000 rd 1100111 JALR
imm[12]10:5] rs2 sl 000 imm|4:1]11] 1100011 BEQ
imm[12[10:5] rs2 rsl 001 imm(4:1]11] 1100011 BNE
imm/[12[10:5] rs2 rsl 100 imm[4:1]11] 1100011 BLT
12[10:5] rs2 sl 101 imm|4:1]11] 1100011 BGE
imm[12]10:5] rs2 sl 110 imm|[4:1]11] 1100011 BLTU
imm/[12]10:5] rs2 sl 111 imm|[4:1]11] 1100011 BGEU
imm/[11:0] rsl 000 rd 0000011 LB
imm]|11:0] sl 001 rd 0000011 LH
imm]|11:0] rsl 010 rd 0000011 LW
imm][11:0] rsl 100 rd 0000011 LBU
imm[11:0] sl 101 rd 0000011 LHU
imm[11:5] rs2 sl 000 imm|4:0] 0100011 SB
imm/[11:5] rs2 rsl 001 imm|4:0] 0100011 SH
imm|11:5] rs2 rsl 010 imm/[4:0] 0100011 SW
imm]|11:0] sl 000 rd 0010011 ADDI
imm]|11:0] sl 010 rd 0010011 SLTT
imm/[11:0] sl 011 rd 0010011 SLTTU
imm/[11:0] rsl 100 rd 0010011 XORI
imm][11:0] sl 110 rd 0010011 ORI
imm]|11:0] rsl 111 rd 0010011 ANDI
0000000 shamt rsl 001 rd 0010011 SLLI
0000000 shamt rsl 101 rd 0010011 SRLI
0100000 shamt rsl 101 rd 0010011 SRAT
0000000 rs2 rsl 000 rd 0110011 ADD
0100000 rs2 rsl 000 rd 0110011 SUB
0000000 152 sl 001 rd 0110011 SLL
0000000 rs2 rsl 010 rd 0110011 SLT
0000000 rs2 rsl 011 rd 0110011 SLTU
0000000 rs2 rsl 100 rd 0110011 XOR
0000000 rs2 rsl 101 rd 0110011 SRL
0100000 rs2 rsl 101 rd 0110011 SRA
0000000 rs2 rsl 110 rd 0110011 OR
0000000 52 sl 111 rd 0110011 AND
| pred | succ rsl 000 rd OOUL1T1 FENCE
000000000000 00000 000 00000 1110011 ECALL
000000000001 00000 000 00000 1110011 EBREAK

www.iaik.tugraz.at

The RV32lI
Instruction Set

* 40 instructions

* Categories:

Integer Computational
Instructions

Load and Store Instructions
Control Transfer Instructions
Memory Ordering Instructions

Environment Call and
Breakpoints

33



Integer Computational Instructions

0000000 rs2 rsl 000 rd 0110011
0100000 rs2 rsl 000 rd 0110011
0000000 rs2 rsl 001 rd 0110011
0000000 rs2 rsl 010 rd 0110011
0000000 rs2 rsl 011 rd 0110011
0000000 rs2 rsl 100 rd 0110011
0000000 rs2 rsl 101 rd 0110011
0100000 rs2 rsl 101 rd 0110011
0000000 rs2 rsl 110 rd 0110011
0000000 rs2 rsl 111 rd 0110011

ADD
SUB
SLL
SLT
SLTU
XOR
SRL
SRA
OR
AND

 All instructions take two input registers (rs1 and rs2) and compute the

resultin rd

e Example:subr3,rl,r2 computesr3=rl-r2



Integer Computational Instructions

0000000 rs2 rsl 000 rd 0110011 ADD
0100000 rs2 rsl 000 rd 0110011 SUB
0000000 rs2 rs1 001 rd 0110011 | SLL . Logic Functions
0000000 rs2 rsl 010 rd 0110011 SLT
0000000 52 1 011 rd 0110011 | SLTU * AND
0000000 rs2 rsl 100 rd 0110011 XOR  OR
0000000 rs2 rsl 101 rd 0110011 SRL
0100000 rs2 sl 101 rd 0110011 | SRA * XOR
0000000 rs2 rsl 110 rd 0110011 OR
0000000 rs2 rsl 111 rd 0110011 AND

e Arithmetic e Shifts * Compares

 ADD (Addition)
e SUB (Subtraction)

e SLL (Logical Shift Left)
* SRL (Logical Shift Right)

* SRA (Arithmetic Shift Right)

e SLT (Set on Less Than)

e SLTU (Set on Less Than —
unsigned)
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A First Simple Datapath with Control for Our
CPU

Read Port A
Register File
Data >ALU

R3, R2,

Read Port B > :‘ RISC ®

00010 00011 o
This simple datapath

essentially allows us to

\ perform R-type instructions

36



Processing Unit

Data
Registers

Control Unit

Instruction Program
Register Counter

CPU

Input

(Keyboard, Disc,
Network, ...)

Output
(Monitor, Printer,
Network, Disc, ...)

Let’s learn about memories!

www.iaik.tugraz.at
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Memory



Memory

address

write

(0: don’t write,

1: write)

data
input

00:
04:
08:
OC:
10:
14.
18:
1C:
20:
24:
28:
2C:

383200002
03214002
383200002
03214002
B3812000
23243002
/3001000
00000000
00000000
00000000
2A000000
0D000000

data
output

www.iaik.tugraz.at
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Our Memories are RAMs

Random Access Memory

(“Memory where arbitrary read and write accesses can be performed”)
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Reading from memory

010101 ... 1010101

Reading from memory

41
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Writing to Memory

Writing to memory

010101 ... 1010101

Reading from memory

42
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A Word in Memory in Case of a 32-bit System

Word in memory
(“Speicherwort”)

010101 ... 010101

Writing

1 Word consists of

32 bit = 4 byte

Reading

z.at

43
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Each Byte in Memory Has an Address

Address

(increment by 1
is an increment
of the position
by 1 byte)

Address:

010101 ...
010101 ...
110100 ...
010111 ...
110100 ...
010111 ...
010111 ...
010101 ...
110100 ...
010111 ...
010101 ...
110100 ...
010111 ...
010101 ...
110100 ...
010111 ...

1010101
1010101
0011101
1000001
0011101
1000001
1000001
1010101
0011101
1000001
1010101
0011101
1000001
1010101
0011101
1000001

1 Word = 4 byte = 32 bit

44



The Indices of the Bits Within a Word in

Memory

Address:

010101 ...
010101 ...
110100 ...
010111 ...
110100 ...
010111 ...
010111 ...
010101 ...
110100 ...

010111 ...
010101 ...
110100 ...
010111 ...
010101 ...
110100 ...

10111 ...

Bit 31

1010101
1010101
0011101
1000001
0011101
1000001
1000001
1010101
0011101
1000001
1010101
0011101
1000001
1010101
0011101
100000

Bit 0

www.iaik.tugraz.at
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Memory

address

(32 wires,
where to read from
or where to store to)

write

(1 wire
0: don’t write,
1: write)

data
input

(32 wires)

OxFF..FF

.. 110100

0001001 ... 110100

0001001 ... 110100

0001001 ... 110100

.. 110100

clk (when to store)

data
output

(32 wires)

www.iaik.tugraz.at
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Endianess

* There are two options for the sequence of storing the bytes of a word
In memory:
* Little endian: least significant byte is at the lowest address
* Big endian: most significant byte is at lowest address

32-bit integer 32-bit integer
Memory 0A0BOCOD 0A0BOCOD Memory
a:|0A| = —> Ob
atl: 0B|<—— L > a+1:j0C
at2:/0C | = > a+2: 0B
a+3:/0D| = > a+3:|0A
: Big-endian Little-endian :
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Endianess - Example

CPU Register Content

(little endian)

02002083
in Memory 00: 83200002 N N
32-bit integer 32-bit integer

: (3)22142.88(2) Memory 0A0BOCOD 0A0BOCOD Memory

. 23243002 a:|0A | <— N P

- 73001000 a+1:|0B|<—— L > a+1:]0C

© 00000000 a+2:0C| = > a+2:|0B

- 00000000 a+3:|0D) < —> a+3:/0A
50 2A000000 5 Big-endian Little-endian :
24: 0D000000 .




Building Memories in Practice

* Building Memories based on standard flip flops (FFs), decoders and
multiplexers would be extremely expensive!

* Note: The functionality of a memory is less than what is available in a
set of FFs:
* A set of FFs allows that in each cycle a different value is written to each FF
* A set of FFs allows that in each cycle the content of each FF is read

- A single port read/write memory requires only that it is possible to
read/write one memory cell at a time



www.iaik.tugraz.at

1 bit in each of

Basic Idea of Memory Design the cell of the

array

e Example: A RAM with a one bit read/write
port

* Memories are built using so-called memory
cells. Each cell can store one bit

* The memory cells are placed on a chip next to
each other and form a rectangular structure:
the so-called cell array.

50
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Basic Idea of Memory Design

* A bitline connects all memory cells of a column
vertically (yellow)

* A wordline connects all memory cells of a row
horizontally
e This basic structure is used for all kinds of memories:
* Non-volatile memory (Flash memory)
» Static memory (SRAM)
* Dynamic memory (DRAM)
* DDR memory

* Each memory type is for different trade-offs with
respect to size, speed, ...

51
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Basic Idea of Read/Write for DRAM

A DRAM cell just consists of a single transistor
and a capacitance that stores the data value

* In steady state (no access) all bitlines and !
wordlines are disconnected from the power 5IIC
supply (i.e. they are floating) b

= GND

Tosaka, CC BY 3.0 52
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Basic Idea of Read/Write for DRAM

* Writing a cell:
* Set corresponding bitline to the desired storage value
* Set corresponding wordline to high

—This charges the capacitance of the desired cell to the
desired storage value

o_L

¢ Reading a cell: — Bit line
* Pre-charge the corresponding bitline to the desired 5;(3
voltage value - Word s
e Disconnect the bitline T 3+_[FET °?
* Set the corresponding wordline to high
- The bitline keeps its value, if the stored value is high or i 4J'c

is pulled to low, if the stored value is zero ! L

Tosaka, CC BY 3.0 53



Memories

* There are many details to know and learn about
memories = memories are highly optimized components
of a computer system (The size of a memory cell has a
huge multiplication effect)

* In this lecture, we focus on the top-level view

* With “memory” we mean a single-port read and single-
port write memory for 32-bit values

Memory

Address

Data

Output




Datapath Including Data Memory and Sign

Extension
te/halfwor

T
L:

Read Port A \

| > »| Address
Register File
D
IR J pata > ALY ata
Memory
Read Port B T:D_L | Data

ign ext. for
immediat




RV 321 Base Instruction Set
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Arithmetic/Logic operations
were already possible with
our first version of the ALU

imm[31:12] rd 0110111 LUI
imm[31:12] rd 0010111 AUIPC
imm[20[10:1]11]19:12] rd 1101111 JAL
imm]|11:0] sl 000 rd 1100111 JALR
imm[12[10:5] rs2 sl 000 imm|4:1]11] 1100011 BEQ
imm[12[10:5] rs2 rsl 001 imm(4:1]11] 1100011 BNE
imm/[12[10:5] rs2 rsl 100 imm[4:1]11] 1100011 BLT
imm|[12[10:5] rs2 sl 101 imm|4:1]11] 1100011 BGE
imm|[12[10:5] rs2 sl 110 imm|[4:1]11] 1100011 BLTU
imm|[12[10:5] rs2 sl 111 imm|[4:1]11] 1100011 BGEU
imm/[11:0] rsl 000 rd 0000011 LB
imm]|11:0] sl 001 rd 0000011 LH
imm]|11:0] rsl 010 rd 0000011 LW
imm][11:0] rsl 100 rd 0000011 LBU
imm]|11:0] sl 101 rd 0000011 LHU
imm[11:5] rs2 sl 000 imm|4:0] 0100011 SB
imm/[11:5] rs2 rsl 001 imm|4:0] 0100011 SH
imm|11:5] rs2 rsl 010 imm/[4:0] 0100011 SW
imm]|11:0] sl 000 rd 0010011 ADDI
imm]|11:0] sl 010 rd 0010011 SLTT
imm|11:0] sl 011 rd 0010011 SLTTU
imm/[11:0] rsl 100 rd 0010011 XORI
imm][11:0] sl 110 rd 0010011 ORI
imm]|11:0] rsl 111 rd 0010011 ANDI
0000000 shamt rsl 001 rd 0010011 SLLI
0000000 shamt rsl 101 rd 0010011 SRLI
0100000 shamt rsl 101 rd 0010011 SRAT
0000000 rs2 rsl 000 rd 0110011 ADD
0100000 rs2 rsl 000 rd 0110011 SuB
0000000 152 sl 001 rd 0110011 SLL
0000000 rs2 rsl 010 rd 0110011 SLT
0000000 rs2 rsl 011 rd 0110011 SLTU
0000000 rs2 rsl 100 rd 0110011 XOR
0000000 rs2 rsl 101 rd 0110011 SRL
0100000 rs2 rsl 101 rd 0110011 SRA
0000000 rs2 rsl 110 rd 0110011 OR
0000000 52 sl 111 rd 0110011 AND
m | pred | succ rsl 000 rd OOUL1T1 FENCE
000000000000 00000 000 00000 1110011 ECALL
000000000001 00000 000 00000 1110011 EBREAK

56



RV 321 Base Instruction Set
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Additional operations that
we can perform with our
updated datapath:

Load/Store Operations

imm[31:12 rd 0110111 LUI
imm|31:12 rd 0010111 AUIPC
imm[20[10:1]11]19:12] rd 1101111 JAL
imm]|11:0] sl 000 rd 1100111 JALR
imm[12[10:5] rs2 sl 000 imm|4:1]11] 1100011 BEQ
imm[12[10:5] rs2 rsl 001 imm(4:1]11] 1100011 BNE
imm/[12[10:5] rs2 rsl 100 imm[4:1]11] 1100011 BLT
imm|[12[10:5] rs2 sl 101 imm|4:1]11] 1100011 BGE
imm|[12[10:5] rs2 sl 110 imm|[4:1]11] 1100011 BLTU
imm/[12[10:5] rs? rsl 111 imm/[4:1]11] 1100011 BGEU
imm/[11:0] rsl 000 rd 0000011 LB
imm]|11:0] sl 001 rd 0000011 LH
imm]|11:0] rsl 010 rd 0000011 LW
imm][11:0] rsl 100 rd 0000011 LBU
imm]|11:0] sl 101 rd 0000011 LHU
imm[11:5] rs2 sl 000 imm|4:0] 0100011 SB
imm/[11:5] rs2 rsl 001 imm|4:0] 0100011 SH
imm/[11:5] rs2 rsl 010 imm/4:0] 0100011 SW
T 11:0] TSI 000 rd 0010011 | ADDI |
imm]|11:0] sl 010 rd 0010011 SLTT
imm|11:0] sl 011 rd 0010011 SLTTU
imm/[11:0] rsl 100 rd 0010011 XORI
imm][11:0] sl 110 rd 0010011 ORI
imm]|11:0] rsl 111 rd 0010011 ANDI
0000000 shamt rsl 001 rd 0010011 SLLI
0000000 shamt sl 101 rd 0010011 SRLI
0100000 shamt rsl 101 rd 0010011 SRAT
0000000 rs2 rsl 000 rd 0110011 ADD
0100000 rs2 rsl 000 rd 0110011 SuB
0000000 152 sl 001 rd 0110011 SLL
0000000 rs2 rsl 010 rd 0110011 SLT
0000000 rs2 rsl 011 rd 0110011 SLTU
0000000 rs2 rsl 100 rd 0110011 XOR
0000000 rs2 rsl 101 rd 0110011 SRL
0100000 rs2 rsl 101 rd 0110011 SRA
0000000 rs2 rsl 110 rd 0110011 OR
0000000 52 sl 111 rd 0110011 AND
fm ‘ pred | succ rsl 000 rd 0001111 FENCE
000000000000 00000 000 00000 1110011 ECALL
000000000001 00000 000 00000 1110011 EBREAK

Additional operations that
we can perform with our
updated datapath:

Operations using immediate
values
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Example: Load Word

* Assembly:
* LW rd, offset(rs1)

* Machine language

imm[l 1 :[)j

rsl

010

rd

* Load from data from memory at address (rsl1+imm) and store in rd

* Functionality:

* Loads a word (32 bits / 4 bytes) from memory into a register

* Example applications

* |oad data from a pointer by setting offset to zero (LW rd, 0xO(rs1))
* |oad data from a pointer providing a relative offset (LW rd, offset(rs1))
* |oad data from a fixed address by setting rs1 to x0 (LW rd, addr(x0))

LW



imm|11:0]

rsl

010

rd

0000011

Example:

x5, 0x16(x1)

IR

\ 4

Ox16 ign ext. for
immediat

Data

Read Port A x1

Register File

R d
5 1

v

—— 3lgn ext. for loa
te/halfwor

X1+0x16

\ 4

Address

Data

Data

Memory

Ox16

\ 4
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LW
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More Load Instructions

| [ooooo1l | LB
imm|11:0 [0 0000011 LH

i I]:l"ll I
5]
i 11:00] rs] (10 (000011 LW
| | |
I

|
I
- | + -
i 11:00] L0 rl 000001 | LBl
l .

imm|11:0, BRI 0000011 | LHU

e LBU (Load Byte Unsigned) and LHU (Load Halfword Unsigned) work
exactly the same way as LW (Load Word) except for the fact that they
only load 8 bit /16 bit instead of 32 bit. The unused bits are zero

e LB and LH work like LBU und LHU, but perform sign extension for the
upper bits



Example: Store Word

* Assembly:
* SWrs2, offset(rs1)

* Machine language

imm|11:5]

rs2

rsl

010

imm|4:0]

0100011

e Store the value in rs2 to memory address (rs1+imm)

* Functionality:

» Store a word (32 bits / 4 bytes) to memory

* Example applications

» store data to a pointer stored in a register by setting offset to 0 (SW rs2, 0x0(rs1))

» store data to pointer + offset (SW rs2, offset(rs1))
» store data to an absolute address (SW rs2, addr(x0))

SW



imm|11:5] rsl 010 imm|4:0] 0100011
/ ~— Jign ext. for loa
te/halfwor
Example: Ox53(x1) I\I
eadrorna XL [N X1+0x53
> » Address
Register File Data
IR > AL
Data “]_L> U Memory
Read Port B » Data
|

O0x53 ign ext. for
immediat

Ox53

\ 4
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SW
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More Store Instructions

imm[11:5] ' rs2 [ sl | 000 | imm[40] | 0100011 | SB
| 11:5 rs2 s | (o1 L1111 [4:0 0100011 sH
imm|11:5] rs2 s (10 TTRIRY: |4:0] 0100011 S

* SB (Store Byte) and SH (Store Halfword) work exactly the same way as
SW (Store Word) except for the fact that they only store the lowest 8
bit /16 bit of the rs2 register instead of the full 32 bit.

* Note that sign extension is not necessary for storing. To illustrate this
consider the representation of -1 as 32 bit value and as 8 bit value.



RV 321 Base Instruction Set
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Additional operations that
we can perform with our
updated datapath:

Load/Store Operations

imm[31:12 rd 0110111 LUI
imm|31:12 rd 0010111 AUIPC
imm[20[10:1]11]19:12] rd 1101111 JAL
imm]|11:0] sl 000 rd 1100111 JALR
imm[12[10:5] rs2 sl 000 imm|4:1]11] 1100011 BEQ
imm[12[10:5] rs2 rsl 001 imm(4:1]11] 1100011 BNE
imm/[12[10:5] rs2 rsl 100 imm[4:1]11] 1100011 BLT
imm|[12[10:5] rs2 sl 101 imm|4:1]11] 1100011 BGE
imm|[12[10:5] rs2 sl 110 imm|[4:1]11] 1100011 BLTU
imm/[12[10:5] rs? rsl 111 imm/[4:1]11] 1100011 BGEU
imm/[11:0] rsl 000 rd 0000011 LB
imm]|11:0] sl 001 rd 0000011 LH
imm]|11:0] rsl 010 rd 0000011 LW
imm][11:0] rsl 100 rd 0000011 LBU
imm]|11:0] sl 101 rd 0000011 LHU
imm[11:5] rs2 sl 000 imm|4:0] 0100011 SB
imm/[11:5] rs2 rsl 001 imm|4:0] 0100011 SH
imm/[11:5] rs2 rsl 010 imm/4:0] 0100011 SW
T 11:0] TSI 000 rd 0010011 | ADDI |
imm]|11:0] sl 010 rd 0010011 SLTT
imm|11:0] sl 011 rd 0010011 SLTTU
imm/[11:0] rsl 100 rd 0010011 XORI
imm][11:0] sl 110 rd 0010011 ORI
imm]|11:0] rsl 111 rd 0010011 ANDI
0000000 shamt rsl 001 rd 0010011 SLLI
0000000 shamt sl 101 rd 0010011 SRLI
0100000 shamt rsl 101 rd 0010011 SRAT
0000000 rs2 rsl 000 rd 0110011 ADD
0100000 rs2 rsl 000 rd 0110011 SuB
0000000 152 sl 001 rd 0110011 SLL
0000000 rs2 rsl 010 rd 0110011 SLT
0000000 rs2 rsl 011 rd 0110011 SLTU
0000000 rs2 rsl 100 rd 0110011 XOR
0000000 rs2 rsl 101 rd 0110011 SRL
0100000 rs2 rsl 101 rd 0110011 SRA
0000000 rs2 rsl 110 rd 0110011 OR
0000000 52 sl 111 rd 0110011 AND
fm ‘ pred | succ rsl 000 rd 0001111 FENCE
000000000000 00000 000 00000 1110011 ECALL
000000000001 00000 000 00000 1110011 EBREAK

Additional operations that
we can perform with our
updated datapath:

Operations using immediate
values
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Example: ADDI

* Assembly:
 ADDI rd, rs1, immediate

* Machine language

imm/|11:0] | rsl - 000 | rd 0010011 ADDI

e Computes rd =rsl +imm

* Functionality:
e Computes rd =rsl +imm
* Example applications
* Move content of one register to another register by setting immediate to 0 (ADDI rd,rs1,0)

» Set a register to a constant value by using x0 as source: (ADDI rd, x0, immediate)
* Increment/decrement a register by setting rd=rs (e.g. ADDI x1, x1, 1)
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Example:

imm/|11:0]

|

x1, x1, 0x42

IR

rd

0010011

X1+0x42

Read Port A x1

N

Register File

\ 4

Data “]_L> ALU
Read Port B
I

v

—— 3lgn ext. for loa
te/halfwor

\ 4

Ox42 ign ext. for
immediat

0x42

\ 4

\ 4

Address

Data

Data
Memory

| ADDI
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More Operations with Immediates

imm[31:12] [ rd [ 0110111 ] LUI
i 11:0° T sl oo | rd 0010011 ADDI
i 11:0] rs] | 010 rd 0010011 | SLTI
imm|11:0] s oo ] rd 0010011 | SLTIU
imm|11:0] rs] 100 rd 0010011 XORI
imm[11:0] | sl [110 ] rd | 0010011 | ORI
i 11:0° [ sl Foar ] rel [ 0010011 | ANDI
DOO0000 | shamt =] [o01 ] re [ 0010011 SLLI
0000000 | shamt rs] 1| rd [ 0010011 | SRLI
0100000 | shamt s ] 01| re L 0010011 | SRALI

* LUI allows to load 20 bits into the upper bits of a register; together with ADDI this allows to set a
register to a 32 bit constant value

* SLTI sets the register rd to 1, if rs1 is less than the sign-extended immediate; SLTIU is the unsigned
version

e XORI, ORI, ANDI are logic operations with immediates

e SLLI, SRLI, SRAI are shift operations, where the 5 bit immediate “shamt” defines the shift amount



(

Processing Unit

Data
Registers

gy
Control Unit l

Instruction Program

I Register Counter I

Let’s learn about control!

CPU
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Input

(Keyboard, Disc,
Network, ...)

Output
(Monitor, Printer,
Network, Disc, ...)
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Adding Instruction Memory

) ~—_ Sign ext. for load
r W

Read Port A > o Address
Register File
g Data

. o Data >ALU
Instruction Memory
Memory Read Port B *| Data
» PC [-®>| Address Instruction T

ign ext. for
immediat




Instruction Memory

* The instruction memory stores a sequence of
instruction

* The program counter (PC) is incremented by 4 in
each cycle and reads one instruction after the
other

* This allows executing a static batch of
instructions

J{ PC

Instruction
Memory

—&-»1 Address Instruction




Extending the datapath for conditional branch
iInstructions

. [
rA — Jign ext. for load
\: te/halfwor
Read Port A > »| Address
* Register File
pat : > AW Data
Instruction o Memory
Memory Read Port B *| Data
» PC » Address  Instruction T
]

_olgn ext. for
immediat
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imm[31:12] rd 0110111 LUI
imm[31:12] rd 0010111 AUIPC
imm[20[10:1]11]19:12] rd 1101111 JAL
imm/11:0] sl 000 rd 1100111 JALR
imm|[12(10:5] rs2 sl 000 imm|4:1]11] 1100011 BEQ
imm[12[10:5] rs2 rsl 001 imm(4:1]11] 1100011 BNE
imm/[12[10:5] rs2 rsl 100 imm[4:1]11] 1100011 BLT
12[10:5] rs2 sl 101 imm|4:1]11] 1100011 BGE
imm[12]10:5] rs2 sl 110 imm|[4:1]11] 1100011 BLTU
imm/[12]10:5] rs2 sl 111 imm|[4:1]11] 1100011 BGEU
mmm|L1:U] rsl oou rd UUU0011 LB
imm]|11:0] sl 001 rd 0000011 LH
imm]|11:0] rsl 010 rd 0000011 LW
imm][11:0] rsl 100 rd 0000011 LBU
imm[11:0] sl 101 rd 0000011 LHU
imm[11:5] rs2 sl 000 imm|4:0] 0100011 SB
imm/[11:5] rs2 rsl 001 imm|4:0] 0100011 SH
imm|11:5] rs2 rsl 010 imm/[4:0] 0100011 SW
imm]|11:0] sl 000 rd 0010011 ADDI
imm]|11:0] sl 010 rd 0010011 SLTT
imm/[11:0] sl 011 rd 0010011 SLTTU
imm/[11:0] rsl 100 rd 0010011 XORI
imm][11:0] sl 110 rd 0010011 ORI
imm]|11:0] rsl 111 rd 0010011 ANDI
0000000 shamt rsl 001 rd 0010011 SLLI
0000000 shamt rsl 101 rd 0010011 SRLI
0100000 shamt rsl 101 rd 0010011 SRAT
0000000 rs2 rsl 000 rd 0110011 ADD
0100000 rs2 rsl 000 rd 0110011 SUB
0000000 152 sl 001 rd 0110011 SLL
0000000 rs2 rsl 010 rd 0110011 SLT
0000000 rs2 rsl 011 rd 0110011 SLTU
0000000 rs2 rsl 100 rd 0110011 XOR
0000000 rs2 rsl 101 rd 0110011 SRL
0100000 rs2 rsl 101 rd 0110011 SRA
0000000 rs2 rsl 110 rd 0110011 OR
0000000 52 sl 111 rd 0110011 AND
‘ pred | succ rsl 000 rd 0001111 FENCE
000000000000 00000 000 00000 1110011 ECALL
000000000001 00000 000 00000 1110011 EBREAK

Additional operations that
we can perform with our
updated datapath:

Conditional Branch
Operations

72



Example: BEQ

e Assembly:
e BEQ s, rs2, offset

* Machine language
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imm[12]10:5]

rs2

rsl

000

imm|[4:1|11]

1100011

BEQ

* Branch to location PC + offset, if rs2 ==rs1

* Functionality:

e Branch if equal by to address PC + imm*2

e Example applications
* Implement a branch to secure code, if password was entered correctly
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imm|[12]10:5] rs2 . 1sl . 000 | imm[4:1]11] 1100011
N
Example: X1, x/, 0x42 —
|/ 0x42
) ) _—Sign ext. for load
I\’ |/ te/halfwor
RN
Read Pcl)rt A > o Address
! . .
DReglster File > AL Data
Instruction e Memory
Memory Read Port B *| Data
» PC »| Address  Instruction 1 T

_olgn ext. for
immediat

v

BEQ
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More Conditional Branches

imm|[12]10:5] rs2 rsl 000 | imm|4:1|11] 1100011 BEQ
imm|12|10:5] rs2 rsl 001 imm|[4:1]11] 1100011 BNE
imm|[12|10:5)] rs2 rsl 100 | imm|4:1|11] 1100011 BLT
imm|12|10:5] rs2 rsl 101 imm|[4:1]11] 1100011 BGE
imm|[12]10:5)] rs2 rsl 110 | imm[4:1{11] 1100011 BLTU
mm[12[10:5) 152 sl 111 | imm[&1[11] | 1100011 | BGEU

 BNE (Branc

n if not equal)

* BLT (Branch if less than)

* BGE (Branch if greater of equal)

* BLTU (Branch if less than unsigned)

* BGEU (Branch if greater of equal unsigned)
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igh-Level Overview (Single Cycle Datapath)
f |

~—_Jign ext. for load
I\’ te/halfwor

I Read Port A R \

» Address
? Register File
5 : > AW Data
o ata
Instruction Memory
Memory Read Port B *| Data
» PC » Address  Instruction T
]

_olgn ext. for
immediat
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Conditional Branch
Operations

.

Load/Store Operations

_

Operations using immediate
values

imm[31:12 rd 0110111 LUI
imm|31:12 rd 0010111 AUIPC
imm[20[10:1]11]19:12] rd 1101111 JAL
imm(11-0] sl 000 1 1100111 TAT R
imm[12[10:5] rs2 sl 000 imm|4:1]11] 1100011 BEQ
imm[12[10:5] rs2 rsl 001 imm(4:1]11] 1100011 BNE
imm/[12[10:5] rs2 rsl 100 imm[4:1]11] 1100011 BLT
imm|[12[10:5] rs2 sl 101 imm|4:1]11] 1100011 BGE
imm|[12[10:5] rs2 sl 110 imm|[4:1]11] 1100011 BLTU
imm/[12[10:5] rs? rsl 111 imm/[4:1]11] 1100011 BGEU
imm/[11:0] rsl 000 rd 0000011 LB
imm]|11:0] sl 001 rd 0000011 LH
imm]|11:0] rsl 010 rd 0000011 LW
imm][11:0] rsl 100 rd 0000011 LBU
imm]|11:0] sl 101 rd 0000011 LHU
imm[11:5] rs2 sl 000 imm|4:0] 0100011 SB
imm/[11:5] rs2 rsl 001 imm|4:0] 0100011 SH
imm/[11:5] rs2 rsl 010 imm/4:0] 0100011 SW
T 11:0] TSI 000 rd 0010011 | ADDI |
imm]|11:0] sl 010 rd 0010011 SLTT
imm|11:0] sl 011 rd 0010011 SLTTU
imm/[11:0] rsl 100 rd 0010011 XORI
imm][11:0] sl 110 rd 0010011 ORI
imm]|11:0] rsl 111 rd 0010011 ANDI
0000000 shamt rsl 001 rd 0010011 SLLI
0000000 shamt sl 101 rd 0010011 SRLI
0100000 shamt rsl 101 rd 0010011 SRAT
0000000 rs2 rsl 000 rd 0110011 ADD
0100000 rs2 rsl 000 rd 0110011 SuB
0000000 152 sl 001 rd 0110011 SLL
0000000 rs2 rsl 010 rd 0110011 SLT
0000000 rs2 rsl 011 rd 0110011 SLTU
0000000 rs2 rsl 100 rd 0110011 XOR
0000000 rs2 rsl 101 rd 0110011 SRL
0100000 rs2 rsl 101 rd 0110011 SRA
0000000 rs2 rsl 110 rd 0110011 OR
0000000 152 151 111 rd 0110011 AND
fm | pred | succ rsl 000 rd 0001111 FENCE
000000000000 00000 000 00000 1110011 ECALL
000000000001 00000 000 00000 1110011 EBREAK

I

Arithmetic/Logic operations
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JAL/JALR

imm[20[10:1[11[19:12]

rd

1101111

imm|[11:0]

rsl

000

rd

1100111

e Jump and Link (JAL):

e Performs an unconditional jump to PC + imm¥*2
e Stores the PC of the next instruction in rd

* Example applications

* Unconditional jump (rd is set to x0 in this case)
e Subroutine call (will be discussed later)
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JAL
JALR
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JAL/JALR

imm[20[10:1[11[19:12]

rd

1101111

imm|[11:0]

rsl

000

rd

1100111

e Jump and Link Register (JALR):
* Performs an unconditional jump to rs1 +imm
 Stores the PC of the next instruction in rd

* Example applications

e Subroutine call/return (will be discussed later)
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JAL
JALR
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High-Level Overview incl. JAL/JALR

1 | + <

~—_Jign ext. for load
I\f te/halfwor

Read Port A R \

TN Register File

+4

»| Address

Data

. Data >ALU
Instruction . Memory
L~ R
Memory Read Port B *| Data
» PC » Address  Instruction T
_~Sign ext. for
immediat




Writing a First Program



Simple Demo Program

* Load values from memory address 0x20, 0x24 into registers
e Add the registers together

e Store the result back to memory at 0x28

Halt the CPU



A First Mapping to Instructions

LW

LW

ADD

SW
EBREAK

rd = x1
rd = x2
rd = x3
rs2 = x3

rsl = x0
rsl = x0
rsl = x1
rsl = x0

offset = 0x20
offset = 0x24

rs2 = x2

offset = 0x28

www.iaik.tugraz.at
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Mapping to Encoding
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Type funct7 rs2 rsl funct3 rd opcode
I-Type  0x20 0 LW 1 LOAD
I-Type  0x24 0 LW 2 LOAD
R-Type DEFAULT 2 1 ADD 3 ALU
S-Type hi(0x28) 3 0 SW lo(0x28) STORE
I-Type  EBREAK 0 PRIV 0 SYSTEM
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Mapping to Binary

Type funct7  rs2 rsi funct3 rd opcode

-Type 0000001 00000 00000 010 00001 0000011
-Type 0000001 00100 00000 010 00010 0000011
R-Type 0000000 00010 00001 000 00011 0110011
S-Type 0000001 00011 00000 010 01000 0100011
I-Type 0000000 00001 00000 000 00000 1110011

85
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Instruction Binary Hexadecimal Bytes

LW 00000010000000000010000010000011 0x02002083 83 20 00 02
LW 00000010010000000010000100000011 0x02402103 03 21 40 02
ADD 00000000001000001000000110110011 0x002081b3 b3 81 20 00
SW 00000010001100000010010000100011 0x02302423 23 24 30 02
EBREAK  00000000000100000000000001110011 0x00100073 73 0010 00

86



Putting the Program (Code and Data) into a

single Memory

Instruction Address Value Bytes

LW 0x00 0x02002083 83 20 00 02

LW 0x04 0x02402103 03 21 4002

ADD 0x08 0x002082b3 b3 81 20 00

SW 0x0c 0x02302423 23 24 3002

EBREAK  0x10 0x00100073 73 001000
0x14 0 00 00 00 00
0x18 0 00 00 00 00
Ox1c 0 00 00 00 00
0x20 42 2a 00 00 00
0x24 13 0d 00 00 00
0x28 0 00 00 00 00

www.iaik.tugraz.at
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Tools to Write Assembler Code

* Writing instruction opcodes by hand is tedious
* An assembler is a tools to assemble machine code for us
* For this lecture we use riscvasm.py

* usage: riscvasm.py program.asm -o program.hex
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The Demo Program Written in Assembly

.org 0x00 # start program at address 0xz00
LW x1, 0x20(x0)
LW x2, 0x24(x0)
ADD x3, x1, x2
SW x3, 0x28(x0)
EBREAK

.org 0x20 # place data at address 0xz20
# ainsert raw data instead of instructions
.word 42
.word 13

89



Try out to assemble and simulate your own code

con04_adding-two-constants
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Watch the Hardware in Action with QtRVSim

Visit https://comparch.edu.cvut.cz/gtrvsim/app/ or use gtrvsim in your
virtual machine to visualize how a sequence of instructions becomes
executed on the single-cycle datapath that we have built

sor 0 Notes:
* riscvasm.py assumes that the
instruction pointer starts at 0x0000,
while QtRVSim starts at 0x0200

Instruction
PC
Oxfrffffff @M‘

* You can upload and build assembly
Code on the website; suitable
source files are available in the
QtRVSim directories of the
examples repository

L
iﬂu
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Interfacing with 1/0O Devices
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How to Implement 1/O?

CPU
Processing Unit

Data
Registers

g ey,
Input
(Keyboard, Disc,

Network, ...)

Control Unit

Output
(Monitor, Printer,
Network, Disc, ...)

N~—_ —

Instruction Program
Register Counter
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RV 321 Base Instruction Set

imm[31:12] rd 0110111 LUI
imm[31:12] rd 0010111 AUIPC
imm[20[10:1]11]19:12] rd 1101111 JAL
imm]|11:0] sl 000 rd 1100111 JALR
imm[12]10:5] rs2 sl 000 imm|4:1]11] 1100011 BEQ
imm[12[10:5] rs2 rsl 001 imm(4:1]11] 1100011 BNE
imm/[12[10:5] rs2 rsl 100 imm[4:1]11] 1100011 BLT
imm|[12[10:5] rs2 sl 101 imm|4:1]11] 1100011 BGE
imm[12]10:5] rs2 sl 110 imm|[4:1]11] 1100011 BLTU
imm/[12[10:5] rs2 rsl 111 imm/4:1]11] 1100011 BGEU
imm|[11:0] rsl 000 rd 0000011 LB
imm]|11:0] sl 001 rd 0000011 LH
imm]|11:0] rsl 010 rd 0000011 LW
imm][11:0] rsl 100 rd 0000011 LBU
imm[11:0] sl 101 rd 0000011 LHU
imm[11:5] rs2 sl 000 imm|4:0] 0100011 SB
imm/[11:5] rs2 rsl 001 imm|4:0] 0100011 SH
imm[11:5] rs2 rsl 010 imm/[4:0] 0100011 SW
imm|11:0] sl 000 rd 0010011 ADDI
imm]|11:0] sl 010 rd 0010011 SLTT
imm/[11:0] sl 011 rd 0010011 SLTTU
imm/[11:0] rsl 100 rd 0010011 XORI
imm][11:0] sl 110 rd 0010011 ORI
imm]|11:0] rsl 111 rd 0010011 ANDI
0000000 shamt rsl 001 rd 0010011 SLLI
0000000 shamt sl 101 rd 0010011 SRLI
0100000 shamt rsl 101 rd 0010011 SRAT
0000000 rs2 rsl 000 rd 0110011 ADD
0100000 rs2 rsl 000 rd 0110011 SUB
0000000 152 sl 001 rd 0110011 SLL
0000000 rs2 rsl 010 rd 0110011 SLT
0000000 rs2 rsl 011 rd 0110011 SLTU
0000000 rs2 rsl 100 rd 0110011 XOR
0000000 rs2 rsl 101 rd 0110011 SRL
0100000 rs2 rsl 101 rd 0110011 SRA
0000000 rs2 rsl 110 rd 0110011 OR
0000000 52 sl 111 rd 0110011 AND
fm ‘ pred | succ rsl 000 rd 0001111 FENCE
000000000000 00000 000 00000 1110011 ECALL
000000000001 00000 000 00000 1110011 EBREAK
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How to
mplement 1/O7?

* We access I/O and other
devices like memory

- we build memory-
mapped peripherals
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Memory-Mapped Peripherals

* Store and load instructions allow addressing 32-bit of memory space

* Not all the memory space that is addressable is used for actual
memory

* We can split the memory space in pieces and assign a certain range to
actual memory and other ranges to peripherals:

— load/store operations write to registers of state machines with additional
functionality (1/O, Co-processors, sound, graphics, ...)
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CPU
Processing Unit

Data
Registers

Input

(Keyboard, Disc,
Network, ...)

Control Unit

Output
(Monitor, Printer,
Network, Disc, ...)

Instruction Program
Register Counter

The bus system takes care of routing the load/store operations to the
correct physical device as defined by the memory ranges
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The Hardware View
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ReadData
WriteData
Address
Processor
MemWrite

Address

Decoder

Enable2

RAM

ROM

Enable3

!

Peripheral 1

Enable4d

Peripheral 2

Yy YVVY
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Memory Mapping — Different for different
Systems

* The memory map is not part of the instruction set architecture and it
is also not defined by RISC V

* There are commonalities, but in the end the memory map is
individual for every device



Real-World Example of a Memory Map

Copyright © 2019, SiFive Inc. All rights reserved. 22
Base Top Attr. Description Notes
0x0000_0000 | 0xP000_OFFF | RWX A | Debug Debug Address Space
0x0000_1000 | OXEEO_1FFF | R XC | Mode Select
0x0000_2000 | OX0000_ 2FFF Reserved
0x0000 3000 | 0x0000 3FFF | RWX A | Error Device
0xX0000 4000 | OX0000 FFFF Reserved On-Chip Non Volatile Mem-
0x0001_0000 | OXEE01_1FFF | R XC Mask ROM (8 KiB) ory
0x0001_2000 | OX0001_FFFF Reserved
0Xx0002_0000 | 0x0002_1FFF | R XC | OTP Memory Region
0x0002_2000 | OXOO1F_FFFF Reserved
0x0200_0000 | OX0200_FFFF | RW A | CLINT
0x0201_0000 | OX07FF_FFFF Reserved
0x0800 0000 | Ox0800 1FFF | RWX A | E31 ITIM (8 KiB)
0x0800 2000 | OXOBFF_FFFF Reserved
0X0CO0 0000 | OXOFFF FFFF | RW A | PLIC
0X1000 0000 | 0X1000 OFFF | RW A [ AON
0xX1000 1000 | 0X1000 7FFF Reserved
0x1000 8000 | 0X1000 8FFF | RW A | PRCI
0X1000 9000 | 0X1000 FFFF Reserved
0X1001_0000 | 0x1001_OFFF | RWw A [ OTP Control
0X1001_1000 | 0X1001_1FFF Reserved
0X1001_2000 | 0X1001_2FFF | RW A [ GPIO : )
On-Chip Peripherals
0Xx1001_3000 | 0X1001_3FFF | RW A [ UARTO
0x1001 4000 | 0x1001 4FFF | RW A [ QSPIO
0x1001 5000 | 0x1001 5FFF | RW A [ PWMO
0x1001 6000 | 0x1001 6FFF | RW A [ I12CO
0x1001 7000 | 0X1002 2FFF Reserved
0xX1002 3000 | 0X1002 3FFF | RW A | UART 1
0X1002_4000 | 0X1002_4FFF | RWw A | SPI1
0X1002_5000 | 0X1002_5FFF | RW A | PWM 1
0x1002_6000 | 0X1003_3FFF Reserved
0X1003_4000 | OX1003_4FFF | RW A | SPI2
0x1003_5000 | 0X1003_5FFF | RW A [ PWM 2
0x1003_6000 | OX1FFF_FFFF Reserved
0X2000_0000 | OX3FFF_FFFF | R XC | QSPI O_Flash Off-Chip Non-Volatile Mem-
(512 MiB)
0x4000 0000 | OX7FFF_FFFF Reserved ory
0X8000 0000 | 0X8000 3FFF | RWX A | E31 DTIM (16 KiB)

0X8000 4000

@XFFFF_FFFF

Reserved

On-Chip Volatile Memary

Table 4: FE310-G002 Memory Map. Memory Attributes: R - Read, W - Write, X - Execute, C -
Cacheable, A - Atomics

The FE310-G002 supports booting from several sources, which are controlled using the Mode
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Select (MSEL[1:0]) pins on the chip. All possible values are enumerated in Table 5.

MSEL

Purpose

00

loops forever waiting for debugger

01

jump directly to 0x2000 0000 (memory-mapped QSPI0)

10

jump directly to 0x0002 0000 (OTP)

11

jump directly to 0x0001 0000 (Mask ROM: Default Boot Mode)

Table 5: Boot media based on MSEL pins
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The Core Used in Our Course: Micro RISC-V

* Micro RISC-V is a very simple CPU that we use for our introductory
programming examples and the practical

* Micro RISC-V implements a large subset of R32|

* Tools and code for micro RISC-V
* Code for Micro RISC-V and examples are available in the examples repo
* Assembler: riscvasm.py
e Simulator: riscvsim.py
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Micro RISC-V Overview

Registers: Instructions:

e Zero Register: x0 e ALU: 0P rd, rsi, rs2

e General Purpose Registers: x1 - x31 e ADD, SUB, AND, OR, XOR, SLL, SRL, SRA
Memory- e Add immediate: ADDI rd, rsil, value

e almost 2 KiB of Memory (0x000 - 0x7£c) o Load upperimmediate: LUI rd, value

e memory-mapped I/O at address 0x7fc e Branch: 0P rs1, rs2, offset
e BEQ, BNE, BLT, BGE

e Jump/Call: JAL rd, offset

e Jump/ Call indirect: JALR rd, offset(rsil)
‘ e Load: LW rd, offset(rsl)

e Store: SW rs2, offset(rsil)

RISC ’ e Halt: EBREAK
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Memory Map in Micro RISC-V

* In Micro RISC-V, the physical memory
map is as follows:

e RAM is located from 0x00000000 to
Ox000007FB

* |/O is located at address OxO00007FC

* The remaining memory range is not
connected (write has no effect; read
returns 0)

* The physical memory map is defined for
each device depending on size of
memory, peripherals, etc.

0x00000000

0x000007fc
0x00000800

Oxffffffff

RAM

/0




Our Design Flow
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.asm file

Assembler (“riscvasm.py”)

Software

Instruction Set

-—-- Simulation
(“riscvsim.py”)

Hardware

SytemVerilog RTL

Simulation
(“iverilog”)

Synthesis
(using yosys)

.sv file

Verilog
Gate-Level Physical Chip
Simulation

Placement, Routing, Chip Manufacturing
(this is part of the course “Digitial System Design”)
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Notes on ASM Examples

* Run “make” to generate .hex files

* Run “make run” to assemble and run the .asm file in the current working
directory with the RTL simulator (micro-RISCV)

* Run “make sim” to simulate the .asm file in the current working directory
with the python asmlib RISC-V simulator

If there are more than one asm files in the current working directory, you
need to specify the target explicitly using “make
run=the_asm_file_without_file_extension_suffix” (and accordingly for
“make sim”).
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Read/Write from Memory vs. Read Write
from 1/O on Our Micro RISC-V CPU

adding-two-constants adding-stdin-numbers

.org 0x00 .org 0x00
# read from memory # read from I/0
LW x1, 0x20(x0) LW x1, 0x7fc(x0)
LW x2, 0x24(x0) LW x2, 0x7fc(x0)
ADD x3, x1, x2 ADD x3, x1, x2
# write to memory # write to I/0
SW x3, 0x24(x0) SW x3, 0x7fc(x0)

EBREAK EBREAK
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Peripherals of QtRVSim

* Also QtRVSim has peripherals.
* Let’s set the color of LED RGB 1:

see con04.02_QtRVSim_simple_examples

_start:
1i x1, SPILED REG BASE
1li x2, Oxaaaa

sw x2, SPILED REG LED RGB1 o(x1)

ebreak
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Peripherals EE
LED RGB 1 LED RGB 2

0000aaaa 00000000

Red Knob Green Knob Blue Knob
238 207 |2 77 %
Word hexadecimal Word decimal
00000000 0
Word binary

00000000000000000000000000000000
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To ease programming, there are pseudo-

Common Pseudo-Instructions

instructions for

common instruction sequences and

instructions that can be derived from
another instruction

nop

li rd, immediate

mv rd, rs

bgez rs, offset
bltz rs, offset
bgtz rs, offset
bgt rs, rt, offset
ble rs, rt, offset
bgtu rs, rt, offset
bleu rs, rt, offset

j offset
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These examples nicely show

addi x0, x0, 0

lui rd, imm[31:12]

addird, rd,
imm[11:0]

addird, rs, O

bge rs, x0, offset
blt rs, x0, offset
blt x0, rs, offset
blt rt, rs, offset
bge rt, rs, offset
bltu rt, rs, offset
bgeu rt, rs, offset

jal x0, offset

the value of having an x0

register that is always O

No operation

Load immediate

Copy register
Branch if > zero
Branch if < zero
Branch if > zero
Branch if >

Branch if <

Branch if >, unsigned
Branch if £, unsigned

Jump
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